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ZEAYEIE: https:/cloud.tencent.com/developer/article/1605195  (keil #E#F 7
MDK5.31 (&) IXE),

—. TEHBEZRE, HEIRTMREK

&R SEM

£ Fi
=)
% MDK531.EXE 2022/9/26 13:47 R FRfERF 896,983 KB
5
¥& TencentDocsSetup.exe 2022/9/2111:19 NEBERF 132,287 KB
¥ Setup_EmbeddedStudio ARM v634...  2022/9/20 13:47 N EER 775,584 KB
J— Nl e B = =
—. BfTRERRF, mifnext
Setup MDK-ARM V5.31 *

Welcome to Keil MDK-ARM
Release 6/2020 G r m K E | L

This SETUP program installs:
MDK-ARM V5_31

This SETUF program may be used to update a previous product installation,
However, you should make a backup copy before proceeding.

It is recommended that you exit all '\Windows programs before continuing with SETUP.

/

i | MNext > | Cancel

Follow the instructions to complete the product installation.



https://cloud.tencent.com/developer/article/1605195

=. Ak accept, =i next

Setup MDK-ARM V5.31

License Agreement a r m K E | L
Please read the following license agreement carefully.

To continue with SETUP, you must accept the terms of the License Agreement. To accept the
agreement, click the check box below.

END USER LICENSE AGREEMENT FOR ARM SOFTWARE A
DEVELOPMENT TOOLS

This end user license agreement ("License”) is a legal agreement between you
(a single individual), or the company or organisation (a single legal entity) that
you represent and have the legal authority to bind, and Arm relating to use of the
Arm Tools. Arm is only willing to license the Arm Tools on condition that you
accept all of the terms of this License. By clicking “| Agree” or by installing or v

[V | agree to all the terms of the preceding License Agreement 2\

Next >> I Cancel |

1 << Back

' LR A SV L SRS Ll R LV b l
M. EERERRERE, ~idnext (RIFEFIRIAERR, MRBTEXFTEIRAERMN
F30)

Folder Selection r m KE I L
Select the folder where SETUP will install files. a

Press 'Nest' to install MDK-ARM to these folders. Press ‘Browse' to select different folders for installation.

- Destination Folders :
Core: |C:\Keil_v5 Browse ... |
Pack: |C:\Users\86182\AppD ata\Local\Arm'\Packs Browse ... I

N
ICEXFA PSR

<«Back | Newt>> |  Cancel
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Setup MDK-ARM V5.31

Customer Information

Please enter your information.

ArmekeiL

Please enter your name, the name of the company for whom you work and your E-mail address.

First Name: j111

Last Name: 8618202175997

Company Name: |11

E-mail: |111

Setup MDK-ARM V5.31

Setup Status

MDK-4RM Setup is performing the requested operations.

Install Files ...
Installing cpp_wsenu.b.

<< Back

Next >> Cancel

ArmekeiL
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t. R finish, TR &%

<< Back
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Setup MDK-ARM V5.31 X
Keil MDK-ARM Setup completed a r m KE I L
MDK-ARM V5.31

MDK-ARM Core Setup has performed all requested operations successfully.
v Show Release Notes.
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file Packs Window Help
| Q| Device:

o packs | Enamples | 1[al  Deviees | Bowras | = bl
Pack |Action | Description Searche - X /
* ARM=CMSIS ‘0 Uptod IVCMSIS (Cortex Microcontroiler Software Interface Standard) Device / | Summary
#- KeilzMDK-Middlewa_|® Uptod l Keil MDK-ARM Professional Middleware for ARM Cortex-M based | . & ARM |QD¢V/
Pack Installer X

Welcome to the Keil Pack Installer
Pack Installer is a utiity for managing Software Packs on the local computer and
provides the following windows:

Packs : Ust and manage Software Packs. Install 8 Pack for access within pVision,

Examples 1 Ust example projects. Copy projects and launch pVision for testing examples.
Devices : List supported devices. Select a device to show related Packs and examples.
Boards : List supported boards. Select 8 board to show related Packs and examples.

Pack Installer connects toxyy. kieil. con/p to obtain the published Software
To install 3 local Software Pack  Flle - Import... from the

[ Show this dialog at startup oK | Help

< J )

{Acton (1 et Updating Pack descrptions downloading htp/download ansog.com/toots/EZ8oards/CNi1/Reeases/AnalogDevies CN 1. M4 DFP pdsc 1 ox CSDTRGREA
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> keSS > WORK (D) > FOcode > ACM32FO0x0_SDK v2.0.2 > EMRE > Ef4E >

e

=+ e EH 3] Fh
0.2 2022/9/1316.11 i
=0 Aisinochip. ACM32F0X0.1.0.1.pack 2021/11/11 10:39 uVision Softwar... 15 KB ]
ModulesDemo_Rev2.0.2.rar 2022/8/1817:23

rsonal

Pack Unzip: Aisinochip ACM32F0X0 1.0.1

Welcome to Keil Pack Unzip
Release 11/2021

WinRAR SR 2,504 KB

X

This program installs the Software Pack:

Aisinochip ACM32F0X0 1.0.1
Aisinochip ACM32F (X0 ARM Cortex-M0 Device Family Pack

Destination Folder

IC: \Users\86182\8ppD ata‘\Localh&rm\Packs\Aisinochip\ACM32FX0\1.0.1

Keil Pack Unzip \
Pack already installed. << Back Cancel
A Click “Next" to replace. | News |




Keil Pack Unzip completed
Aisinochip ACM32FX0 1.0.1

Keil Pack Unzip has performed all requested operations successfully.

N\

Finish
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Select Device for Target 'Target 1'... X

Device |

| Software Packs

Vendor:  Aisinochip
Device: ACM32F070RBT7

Toolset: ARM

Seach:l

Description:

£ @ Aisinochip
& 4% ACM32FOXO Series
@ 48 ACM32F030
2 % ACM32F070

@ % ACM32F4 Series
@ %% ACM32FP4 Series
|

@ ACM32F070CBT7
@ ACM32F070KBU7
@ ACM32FO70RBT7 —

ie=| |The ACM32F0X0 device family contains an ARM Cortex-MO0 processor, -~
up to 64 MHz with a versatile set of on-chip peripherals.

PN | = | o
" { " ,l
0K | Cancel | Help
K3 Manage Run-Time Environment x
Software Component Sel. Vanant Version  Description
® @ cmsis [ ] [ Cortex Microcontroller Software Interface Components
@ 4 CMSIS Driver if ice Dri i MSIS-Dri ificati
© € Compiler |ARM Compiler 160 Compiler Extensions for ARM Compiler 5 and ARM Compiler §
@ 4 File System | MDK-Plus i i i
& € Graphics MDK-Plus
& 4 Network | MDK-Plus
w4 use MDK-Plus
Validation Output Description
| Resolve | Select P...  Details | oK | Cancel I Help |
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Opticns for Target 'Target 1° ®

Device | Target | Output | Listing| Vser Q‘:j—’ O08) |asa | Lisker | Debug | Utilities |

= Symbols 1 Folder Setup
Define: |
M-:I .Core_Drivens'\CMS5I5
.\Core_Drivers'Device
N e &_MWE
P Warrgs: [aviamen =] oo [ = | ||
Optimaaton: [01 =] [ Tum Wamings into Erors Language ©ov: [eutt ]
I Link-Time Optimization: I~ Plain Charis Signed ¥ Short enums wehar
™ Spit Load and Store Muliple ™ Read-Only Position Independent ™ use RTTI . _ .
P s et Pttt it toriorain sy | |[FEAIARASHIHAL LR ARANAOSL ST ROES
\
o | ||
Mac
Controls |
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B C\Users\B6182\Desktop\temp\user\temp1 uvprojx - pVision [Non-Commercial Use License]
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

nwsqal L@ 9 o] e | mornn e G| @ ourroaavent B @ o
{ PRI R A

/t
B R
* Copyright (c) 2008 - 2022, shanghai AisinoChip Co.,Ltd .

* @file main.c

B save As X
« v 4 | « temp > user > app v o T app THRE £ B Team
e
88 v L »dos E- @ Y
@ > A am B2EW
o
ENERESATIEAN,
= Fv
JouM
- R AAA AR AR AR AR AR AR AR A AR A A AR A A A AR R A A AR KRR A Ak
= |y
@ ==
"F‘ AAX KA KRR AR AR A ARAA AR AR AR R KRR AR AR AR AR AN AN/
) w5 ate)
fu32_Baudrate;
UART_WORDLENGTH_8B;
UART_STOPBITS_1;
UART PARITY NONE;

Rebuild started: Project: templ

3

FRE CUR VIEW  FIQEU TSN UTUUY  FERPNEIGN VU 3VAD  WINUUW e

ﬁﬁﬂ'.lﬁ -all")rt‘|°--°|!‘ﬂ.ﬂnl.lf!/lill.lﬂmmmmwe_ugﬂflﬁ | 06 a-

"‘tﬂﬁv'mlwlmg«l E-ﬁl FQ‘).\
ey sl

3% Project: temp1 T/ 1
£ &2 Target1 L L T T T T P PP P
{3 Source Group 1 3 * Copyright (c) 2008 022, Shanghai AisinoChip Co.,Ltd .

gl * 0f1le main.c p
§ ¢ @version vi.0.0 | Manage Project items *
: . ::::;ox )z\g:inocl Froject :'-ll!‘ou«slhnuhullnh | Project Info/Layer |
8 °* @brietf GPIO Tes
9 esesccscssccsssncscsand

10 ¢/ Prosect Torgets: Tres:
| L-'-—ﬁ’-’i-’-é m— - —
12 X

13 UART_HandleTypeDef Uart2

14

15 /eeesssncnannanansininnd L
16 * function : Uarc_Ing

17 * Description: Uart Ing

18 tevrssvcnacnininiiianen

;: ;mm Uart_Init(uint32_t E_I'meﬁ Ea 839%5}253\?5 2

21 Uarc2_Handle.Instanc
22 Uarc2_Handle.Init.Ba
23 Uart2_Handle.Init.Wo
24 Uart2_Handle.Init.St
25 Usrc2 Handle.Init.Pa
26 Uarc2_Handle.Init.Mo
27 Uarc2_Handle.Init.Hw
28

29 HAL_UART_Init (&Uart2
30

31 /* UART_DEBUG_ENABLE
32 printfS("MCU is runn 23 I
33)

34
| | o T~




Manage Project Items

Project Items I!oldcrs/!xtomionsl Books | Project Info/Layer |

Project Targets: 13| X | 4 | ¥ | |Groups: i3|X |4 | ¥ Fies: X 4 ¢
| main System_ACM32F0x0.c
HAL_GPIOc
HAL_UARTc
Startup_ACM32F0x0.s
HAL_EFLASHc

HAL_DMA.c

/ HAL_ERlash_EXlib

I R EIHALSZ S, Baisad
FOLIBSZ/4

Set as Curent Target | Add Fies... |

0K | Canoel Help

1.3 keil /¥, TH. Bf7
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B C:\Users\86182\Desktop\temp\user\temp1..

File Edit View Projet Flash Debug Peripherals Tools SVCS Window Help

wprojx - pVision [Non-Commercial Use License

"B EHP| % OB 9 | e | BB E R EEJE | @ Reset Handler
é&u@-»\‘iﬁ' Target 1 ﬁ"07ﬁ
Project L ] mainc __] W) < |
= ‘% Project: tem) [
= 2 Target1
= & main 4 % m )ptions for Target 'Target
@ ) mainc
= @ HAL

@ ) System_ACM32FOx0.c
@ ] HAL_GPIO.c
@ ] HAL_UART.c

) Startup_ACM32F0x0.s
@ _] HAL_EFLASH.c
@ L] HAL_DMA.c

) HAL_EFlash_EX.lib

Select Folderfor Objects... |

& Create Executable: \Objects'\temp1
¥ Debug Information
eHEXFh

v &'ameHownam\

" Create Library: .\Objects\temp 1lb

13

Name of Executable: [temp1

A R HEXSZ 4

* Qutput
e L ............. 1. P )\*&E ........................................
Device | Tv:otl.istingl User |C/C++ | Asm | Linker | Debug | Utilities|

[ Create Batch File

oK | Cancel

Defaults I Help

< | b=

|

Build Output

compiling HAL DMA.c...
linking...

Program Size: Code=7056 RO-data=23¢ RW-data=40 ZI-data=2488
FromELF: creating hex file...

" _.\Cbjects\templ.axf" - 0 Error(s)

, 0 Warning(s).
Build Time Elapsed: 00:00:02

= R ——

) suild Output | G Find In Files
—. T#H#EF (ACM32FOX0 RIIZHNAEL LRI

J-Link, U-Link2. ST-

Link, CMSIS-DAP, ACM32F4XX R¥|HIFMAELBEREFE: J-Link-V9 (%) UL
F. U-Link2, CMSIS-DAP %, {#H J-Link £ 1Ak, Keil #%F%E MDK5.31 (&)

Mk, J-Link IRFHEILLE V6.70e (&) ML)



Options for Target 'Target 1' X

Dtvicol Target I Outputl Listin;l User I C/C++ I Asm l Linker Debug IUtilitiul

" Use Simulator with restrictions Settings I « Use:
[T Limit Speed to Real-Time

[V Load Application at Startup [V Runto main() ¥V Load

~ Restore Debug Session Settings - Rest
[V Breakpoints [V Toolbox v
[V Watch Windows & Performance Analyzer PR PERAEL P,
[V Memory Display [V System Viewer [V Memory Display [V System Viewer
CPUDLL: Parameter: Driver DLL: Parameter:
|SARMCM3.DLL | ISARMCM3.DLL |
Dialog DLL: Parameter: Dialog DLL: Parameter:
lDARMCMlDLL I-pCMO ITARMCM1.DLL I-pCMO
[~ Wam f outdated Executable is loaded [~ Wam i outdated Executable is loaded

| 0K I Cancel I Defaults | Help |

FiitHy core FFRMRET™H DAP EH#HY, FTINT IXE#IE#X CMSIS-DAP Debugger,
BT Settings EERAIEHEEE., MRFREM Jink TERE, TUSE (FUEH
MCU {& F JFlash %% Fr 8977 7% B pdf).
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1%}

Deviee | Target | Dutpet | Listing| User | C/Tes |An | Linker Debug |Weilities|

CMSIS-DAP Cortex-M Target Driver Setup

€ Use Smuator  with restristions @ Use: [CMSIS-DAP Debugger Debuc |Trace | Plash Dowadond | 3RS H L
[~ Limt Speedto Resk-Tme /
\ CMSIS-DAP - JTAG/SW Adscter | - SW Device
™ Load Appication at Statup M Runto man) M Load Appication at Satup ¥ Aunto man) I"" L] DCODE o Neme
ntakzation Fle inbakzation Fle 1Lig M R anH0 SWDI0 77 AR P
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Restore Debug Session Seatngs Restore Debug Session Setings Frmware Verson: [26 _‘J
W Breakports M Toobex W Breakports M Toobex 7 swi [sv. ;] ¢
¥ Watch Windows 8 Pedonmance Analyzer M Watch Windows ¥ Traceports A N7 c
¥ Memoy Daplay ¥ System Viewer W MemoryDaplay ¥ System Viewer ;"d‘m— b
CPUDLL Parameter Diver DL Paramater 2 RSB
[sammcmaou | [sarmchaoLL [ Conect 8 Reset Options Cache Opticns Dowrload Optons
Dislog DL AL Dislog DLL A Connect: [Nommat v Reset: [Atodatect | | | ¥ CacheCode I Verfy Code Downioad
[oARMCMIDLL foCMO [TARMCHMI OLL [pCMO rif rte‘&rm L ¥ Cache Memory | | I Downkoad to Rash
™ Wam £ outdsted Executable is baded ™ Wam f outdated Executable is koaded
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ﬂ C:\Users\86182\Desktop\temp\user\temp1.uvprojx - pVision [Non-Commercial Use License]

File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
NBEHSP ¥ LB | e=PRAR =/ lz| @ Reset_Handler
@LZJIS!IQ’« "&”%.|Target1 vﬁ\lﬁ—%’em
| JEP— — = = —————
Project ®H ) mainc ] APPh | ) System ACM32FOXO.c |
5% Project: temp! \ ‘ 39 | * Output : None
E]‘aTarget‘ | N 40 A AR R R AR AR R R AR R R R R R R R R R R R R R R R R R R R R R R R R R R R Rk R
= L3 main 1T~ﬂz 41 int main(void)
® J main.c 42 (4
e 43 System Init():
= &9 HAL 44 -
@ L] System ACM32FOx0.c 4s Uart_Init(115200);
@ ) HAL_GPIO.c 46
@ ) HAL_UART.c - & el
L) Startup ACM32F0x0:s a9 printfS("This is USER LED TEST \r\n")
] HAL_EFLASH.c 50
_] HALDMA.c 51 GPIOD_Handle.Pin = GPIO_PIN
) HAL_EFlash_EX.ib 52 GPIOD_ Handle.Mode = GPIO_MOD
53 GPIOD Handle.Pull = GPIO_PUL
54 GPIOD_Handle.Alternate = GPIO_FUN
55
56 HAL GPIO_Init (GPIOD, &GPIOD_Handl
57
58 while (1)
59 [ {
60 HAL GPIO_WritePin(GPIOD, GPIO
61 System Delay MS(500):
. 'Fﬁmlj]{"'g\ 62 HAL GPIO WritePin(GPIOD, GPIO
i T'e” 63 System Delay MS(500):
€4 }
65 - }
66 |}
€7
68 L
< |
Build Output

Build Time Elapsed:

Erase Done.
Programming Done.
Verify OK.

00:00:02
Load "C:\\Users\\86€182\\Desktop\\temp\\user\\Objects\\templ.axt"

Flash Load finished at 13:57:43

=. &7 (BRISAAREBTHEE RS, FE#% T RESET #/5,

RFAIETT),

X GPIO O#&e4=®H] LED KTINERABI, BATBIRE (ZERBILKZR) MRAKAT:



void Uart_Init(uint32_t fu32_Baudrate)
B {
Uart2_Handle.Instance = UART2;
Uart2_Handle.Init.BaudRate = fu32_Baudrate;
Uart2_Handle.Init.WordLength = UART_WORDLENGTH_SBE;
Uart2_Handle.Init.StopBits = UART_STOPBITS_1;
Uart2_Handle.Init.Parity = UART_PARITY_NONE;
Uart2_Handle.Init.Mode = UART_MODE_TX_RX_DEBUG;
Uart2_Handle.Init.HwFlowCtl = UART_HWCONTROL_NONEZ;

HAL_UART_Init(&Uart2_Handle);

/* UART_DEBUG_ENABLE control printfS ¢/

printfS("MCU is running, HCLK=%dHz, PCLK=%dHz\n", System Get_SystemClock(), System Get_APBClock());
=}

void Gpic_set_led()

B¢
printf£S("This is USER LED TEST \r\n");
GPIOD_Handle.Pin = GPIO_PIN_3;
GPIOD_Handle.Mode = GPIO_MODE_OUTPUT_PP;
GPIOD_Handle.Pull = GPIO_PULLUP;
GPIOD_Handle.Alternate = GPIO_FUNCTION_O;
HAL_GPIO_Init(GPIOD, &GPIOD_Handle) F|
while (1)

5] {

HAL_GPIO_WritePin(GPIOD, GPIO_PIN_3, GPIO_PIN_SET);
System Delay MS(500);

HAL_GPIO_WritePin(GPIOD, GPIO_PIN_3, GPIO_PIN_CLEAR);
System Delay MS(500);
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ERE0 =088 BT &= 2¥0s IR B BEFE Xohos

14:18:35. 521]1&*“11 is running, HCLK=64000000Hz, PCLK=64000000Hz

his is USER LED
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@ ximmn | Mj v mijaRis BT, #nE[20 B Fv EFER - |meeNoe ~

[~ ATS ¥ DTR B#E: [115200 |""°“f‘ =
A7 B R Rsscomi i

lE‘T BB RRES

CHBENS. 13 1] XSEHHNHAGRIREE i KET-Threod REARFBRBIHERR KF— 1001 Fi 5K MFO2665RT-Thread *ell&ul
www.daxia.com S:0 [R73 |cOM8 BfIFF 115200bps,8,1,None,None 7
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B C:\Users\86182\Desktop\templuser\temp1.uvprojx - yVision [Non-Commercial Use License]
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
TS HP| % B9 || PR R EE M| B Reset Hander varla]ecs a- @
@W@a'Ié’ﬁ|ulgen vf\]t":’."
: '8 Dime| ) wen 0 S IS
= % Project: temp1 51 )
= #3 Target1 52
=& main 53
@ ) mainc 54 F /\"'“‘Zr
= @ HaL ss by R e N\ EX R
@ ) System_ ACM32FOx0.c 56@/.........................................u.................“....-...
@ ) HAL_GPIO.c 57 | * Function : main
@ ) HAL_UART.c 58 | * Description : The application entry point.
L) Startup ACM32F0x0.5 59 | * Input : None
@ ) HAL_EFLASH.c 60 | * output : None
:EJ HAL DMA.c 61 R
] HAL_EFlash_EX.Iib 62 int main(void)
63 ¢
64 System_Init();
65
€6 Uart_Init(115200);
€7
€8 Gpio_set_led():;
69 while (1)
708 {
71
72 + }
73 |}
74
725, -
K ! | &
Build Output
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File Edt View Project Flash Debug Peripherals
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mﬁﬂm‘ 3 E3 Disassembly

A e Runizfr,

JRULEFFLEAREN RNIEL). ERKERESR, Tk

R YEFETEZVNERBFL

Tools SVCS Window Help

RRR|EEEE Vvae Q-leocos @ BN

@ Reset_Handler

EIV_:Z O-32-RN-0-0-|R-

egi nu\
1 €

x0000110C F7FFFDF4 BL.W

10x0000110A 2000
System_. hu 0:

%5‘_’_

F8)

 Init

68
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=T,

ELRETT, MR
B, ETEIM

i ) rroject | EERegisters I

éé: Uart_Init(115200):
§7:
) mainc ] apPh ]
56[1/hhahtlll‘ L R
57 | * Function : main
58 | * Description : The application entry point.
59 | * Input : None
60 | * Output : None
51L...“.u.“..........“......................................................“.
& 62 int main(void)
. 63 E¢(
= 64 System_Init();
Privileged 63 3 Gt
P 66 Uart_Init(115200);
67

Gpio_set_led():
while(1)
{

REWTS
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o5 Reset SHMEFEN, UEHES
=l Run FERERBIET
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@ C\Users\86182\Desktop\temphuser\temp1.uvprojx - pVision [Non-Commercial Use License]
File Edit View Project Flash Debug m Tools SVCS Window Help

" SHd| L am| 9 System Viewer > ADC # Reset_Handler Ma» | Q-(eoco &-|@-| X
25| E @ B (P 0| 2| & CorePeripherals b E::; 7. W - -
et 28 Dmme T 10 oF Bl s acrens i e
| e
Ragister | value 49 e in(GPIOD, GPIO_PIN_3, GPIO_PIN_CLEAR);
= | 50 Sys — (500) ;
51 }
52 12c1
53 12c2 v
54 - 1251 Property Value
55 Ly WOt GPIO_DIR 0x00000000
seer}iiiiiiiiij lcn k¥ GPIOSET mw LR
57 | * Function LPUART GPIO_CLR 0x00000000
58 | * Descripti - >IN GPIO_ODATA | 0x00000000
59 | * Input ° GPIO_IDATA
60 | * output Py GPIOJEN | 0x00000000
el Lok ok o ok ok ok ok ok ko m k¥ - LR
) : GPIO_IS 0x00000000
62 int main(vol s GPIO_IBE 0x00000000
& 63 El( P » GPIO_IEV 0x00000000
= €4 System -
= s ot P - TIM 13 GPIO_IC Ox 00000000
Mode Threa )
Privilege Privileged p (13 Uart_In =y GPIO_RIS
Stack SF 67 UART1 GPIO_MIS (00000000
® &8 Gpio_se UART2
€9 while (1 UART3
70H { UART4
71 EEE
;i _} } . @D-sassembl-j GPIO1
74
75 b
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@ Insert/Remove Breakpoint

Enable/Disable Breakpoint
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Insert Tracepoint at “a'...
Enable/Disable Tracepoint
Insert/Remove Bookmark
Undo

Redo

Cut

Copy

Paste

Select All

Execution Profiling

Outlining
Advanced

Hexadecimal Display (radix=16)

- wes Ak
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CQuri=F3 va 0x00000000 int
F12 «<Enter expression>
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Registers 2 8 ) mainc | ) APPh | ] System ACM32FOx0c ] Startup ACM32F0x0.s
lh(isnr Value I 3581
B 36 printfs("This is USER LED TEST \r\n");
37
38 GPIOD_Handle.Pin = GPIO_PIN_3;
39 GPIOD_Handle.Mode = GPIO_MODE_OUTPUT_ PP;
40 GPIOD_Handle.Pull = GPIO_PULLUP;
41 GPIOD_Handle.Alternate = GPIO_FUNCTION_O;
42
43 HAL GPIO_Init (GPIOD, &GPIOD_ Handle):
44
45 while (1)
46 - {
47 at+;
48 HAL_GPIO_WritePin(GPIOD, GPIO_PIN 3, GPIO_PIN_SET)
+ 49 System_Delay MS(500);
i 50 HAL_GPIO_WritePin(GPIOD, GPIO_PIN_3, GPIQO_PIN_CLE?
i Mode Thread 51 System_Delay MS(500);
Privilege Privileged 52 }
Stack MEF 53
54
55 H
56 -}
5'?Ej|flijlh‘lilliAl)ll)llhlkllA‘liAli‘lilliAl)ll)ll)lk)lkili)li
58 | * Function : main
59 | * Description : The application entry point.
60 | * Input : None
61 | * Output : None
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Workbench SYSTEMS

« Install IAR Embedded Workbench® for Arm
* Installation and licensing information

* Release notes

* Install drivers

» Explore the installation media

* Exit [ Japanese

—. BTRERRF, Sifinext

IAR Embedded Workbench for Arm 9.30.1 *

Welcome to the InstallShield Wizard for IAR
Embedded Workbench for Arm

The InstallShield Wizard will install AR Embedded Workbench
for Arm on your computer. To continue, click Next.

<>

=. Ak accept, S next



IAR Embedded Workbench for Arm 9.30.1 X

License Agreement
Please read the following license agreement carefully.

SOFTWARE LICENSE
AGREEMENT

December 2021

1.m% R
Concerni e Products: Embedded Trust™, IAR Embedded Workbench®, IAR Visual
Statgh
@ | accept the terms of the license agreement Print
(O do not accept the terms of the license agreement 2"':—}’?/:

4

MY, EEREKT, =i next

IAR Embedded Workbench for Arm 9.30.1 X

Choose Destination Location

Select folder where setup will install files.

J"_‘] Install lAR Embedded Workbench for Arm to:

CAProgram Files\|AR Systems\Embedded Workbench 9.1 Change...

ZRAR

/

T, 2R, HBERETRERZIHMTEHRS AT, SAESRE LR



IAR Embedded Workbench for Arm 9.30.1

USB Driver installation
Selectthe USE drivers to install for your dehug probes

Selectthe USB drivers you want to install on your system

Hiv . Debug probe drivers ~ Description

~[Het Driver installers for debug
~[w]J-Link probes

-[V]ST-LINK

~[VITIFTDI

[ Ticol

~-[v]PEMicro

~[V]TI%DS

;---:lTl FET

[AINU-LINK

|_|D|:|nu|e drivers v
8.22 GB of space required on the C drive

134.59 GB of space available on the C drive /

< Back Cancel

A EESENEXT

IAR Embedded Workbench for Arm 9.30.1

Select Program Folder

Please select a program folder.

Setup will add program icons to the Program Folder listed below. You may type a new folder name,
or select one from the Existing Folders list. Click Next to continue.

Pragrnm Folder:

A-:ceesmues
Administrative Tools
AisinoChip

Beyond Compare 3
Dell

Git

GoldWawve

HP

LeCroy / A

+. s install



IAR Embedded Workbench for Arm 9.30.1

Ready to Install the Program

The wizard is ready to begin installation.
Click Install to begin the installation.

If vou want to review or change any of your installation settings, click Back. Click Cancel to exitthe
wizard.

y

< Back Install Cancel

N FHRERTM, [ finishSEal %

IAR Embedded Workbench for Arm 9.30.1
InstallShield Wizard Complete
The InstallShield Wizard has successfully installed |AR Embedded

Warkbench for Arm. Click Finish to exit the wizard.

[ Jviewthe release notes

. REREFHIHEE, 25 7 FEFNEINTRK SMEFEESSD
"Install","close"B0 T, FrE WzhigREINLEE T,



(] PEmicro Device Drivers Setup - X

Choose Install Location
Choose the folder in which to install PEmicro Device Drivers.

Setup will install PEmicro Device Drivers in the following folder. To install in a different folder,
dick Browse and select another folder. Click Install to start the installation.

Destination Folder
kc: PEMiao PEDrivers]

Space required: 20.2MB
Space available: 124.4GB

(] PEmicro Device Drivers Setup -

Installation Complete
Setup was completed successfully.

< Back Close Cancel
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—. BYHFHTHERX (File—>>New Workspace)

© IAR Embedded Workbench IDE
[File | Edit View Project Tools Window Help

1Y MNew File Ctrl+N _

MNew Workspace

Open File... Ctrl=0

5] Open Workspace...
Open Header/Source File Ctrl+Shift+H

Q] Close Ctrl+F4

ﬂ Save Workspace As...
a Close Workspace

Save Ctri+S
Save As...
Save All

Page Setup...
Print... Ctri+P

by BROE

Recent Files
Recent Workspaces

Messages

—. BExHWA (Project—>>Create New Project...)
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© AR Embedded Workbench IDE - Arm 8.50.9
File Edit View Pr§ E ct | Simulator Tools Window Help

Add Files... ! v (e

st

Add Group... L
Import File List... )

Add Project Connection...
Edit Configurations... main ( )

Remove

vturn 0;
main.c | L) Create New Project... ’

W Output | ® add Existing Project...

£ Options... Alt+F7
Version Control System >

. Make F7

Compile Ctri+F7

@ Rebuild Al

# Clean

@ Batch build... F8
C-STAT Static Analysis 4

) stop Build Ctrl+Break

° Download and Debug Ctri-D

» Debug without Downloading

») | Attach to Running Target
(& Make & Restart Debugger Ctrl=R
Restart Debugger Ctrl+Shift+R

Download >

l Adaman
M. ARkt

=7 Project—>>Options, i%#% C/C++ Complier->>Preprocessor 713k X R .
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© rroject - IAR Embedded Workbench IDE - Arm 8.50.9

(@ Add Group...

[4] import File List...

Add Project Connection...
Edit Configurations...

M CoreDriv X Remove
= W CoreDriv
@ Wl CoreDrid {)  Create New Project...

) i SourceC ? Add Existing Project...

& SourceC
) W Output | % Options... Alt-F7
Version Control System »
0O Make F7
amn -F7J

joad and Debug Ctrl-D

ke & Restart Debugger Crl+R
C JRestart Debugger Ctri+Shift+R
D d »

SFR Setup

b CMSIS-Pack Manager

Open Device Description File »
Save List of Registers...
Total number of errors: 0
Total number of warnings: 0
<

—. %
TEEFFSEAZFZFAY (ACM32F4 25|t BT L5 N AIEIH X H)

[ ] ACM32FOXX.ddf 2022/2/16 10:04 DDF 3244 2KB
|| Flash_ ACM32F0XX.mac 2022/2/7 17:39 MAC 3244 1KB
D FlashACM32F0XX.board 2022/2/16 10:02 BOARD 3744 1KB
D FlashACM32F0XX.flash 2022/2/16 10:05 FLASH 3244 1KB
D FlashACM32F0XX.out 2022/2/16 13:35 OUT X% 21 KB

« 5 ACM32F0XX.ddf I & T IAR g% % B % a9\arm\config\debugger T
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:} > Program Files (x86) I IAR Systems > Embedded Workbench 84 > arm > config > debugger > I v O L TEdeb
& ) ] sem K
Microsemi 202279729 10:42 R
Milandr 2022/9/29 10:43 prgt o3
MindMotion 2022/9/29 10:43 i
MitsubishiElectric 2022/9/29 10:43 prgic==3
NetSilicon 2022/9/2910:43 pr4s ]
NordicSemi 2022/9/29 10:43 prgi 3
Nuvoton 2022/9/29 10:43 BT
NXP 2022/9/29 10:43 i3k
ONSemiconductor 2022/9/29 10:43 i
Qorvo 2022/9/29 10:43 pr4L >
Redpine 2022/9/29 10:43 BT
Renesas 2022/9/29 10:43 R
Samsung 2022/9/29 10:43 prai
SiliconLaboratories 2022/9/29 10:43 i
Socle 2022/9/29 10:43 i
Sonix 2022/9/29 10:43 prgi =
ST 2022/9/29 10:41 i
TexasInstruments 2022/9/29 10:43 i
Toshiba 2022/9/29 10:44 4 s 3
Vorago 2022/9/29 10:44 i
Xilinx 2022/9/29 10:44 {43
v l | ] ACM32FOXX.ddf 2022/2/16 10:04 DDF X% 2 KB I
BHS 4 PN ERET IAR L3 Bk H\arm\config\flashloader T~
> keBBE » OS(C:) * Program Files (x86) llARSyslems » Embedded Workbench 8.4 > arm * config * flashloader I v O Pl
~ &% : R EINS s e
Microsem 202219729 10:42 TAFFE
Milandr 2022/9/29 10:43 prg =
MindMotion 2022/9/2910:43 i
MitsubishiElectric 2022/9/29 10:43 prgi=d
NordicSemi 2022/9/29 10:43 i
Muvoton 2022/9/29 10:43 prgt=3
NXP 2022/9/29 10:43 FE
ONSemiconductor 2022/9/29 10:43 i
Qorvo 2022/9/29 10:43 prg=
Redpine 2022/9/29 10:43 i
Renesas 2022/9/29 10:43 prg s
Samsung 2022/9/29 10:43 ik
SiliconLaboratories 2022/9/29 10:43 hrg’=3
Sonix 2022/9/29 10:43 prgs 3
ST 2022/9/29 10:42 i
Texasinstruments 2022/9/29 10:44 iR
Toshiba 2022/9/29 10:44 i
Voragg 2022/a o0 104 Tl
|1 Flash_ACM32FOXX.mac 2022/2/7 17:39 MAC 3244 1KB
|| FlashACM32F0XX board 2022/2/16 10:02 BOARD 7% 1KB
|7 FlashACM32F0XX flash 2022/2/16 10:05 FLASH =0é% 1 KB
lJ FlashACM32F0XX.out 2022/2/1613:35 OUT i 21KB
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Options for node "demo”

Category:

General Options

Static Analysis

Runtime Checking
C/C++ Compiler
Assembler
Output Converter
Custom Build
Build Actions
Linker

Simulator
CADL

CMSIS DAP
GDB Server
I-jet
J-Link/J)-Trace
TI Stellaris
Nu-Link

PE micro
ST-LINK
Third-Party Driver
TI MSP-FET
TI XDS

Setup Download Images Multicore ExtraOptions Plugins
Driver & Run to
J-Link/)-Trace . ' main

Factory Settings

~ Use macro file(s)

$TOOLKIT_DIR$\config\flashloader\Flash_ACM32F0XX mac

Device description file
“ Override default
$TOOLKIT DIR$\config\debugge\ACM32F0XX.ddf

oK Cancel




Options for node "demo”

Cowoosy Factory Settings
General Options
Static Analysis
Runtime Checking

C/C++ Compiler Setup Download Images Multicore ExtraOptions Plugins

Assembler

T

Custom Build

Build Actions [ Suppress download

Linker
@ Use fashloader()

asfﬂot;bbf © Override default .board file

==

GDB Server

I-jet Edit...

J-Link/J-Trace

TJU-S;I:rs Perform mass erase before flashing

PE micro

ST-LINK

Third-Party Driver

TI MSP-FET

TI XDS

OK Cancel

WziEFE SCO00, {3/ JLINK JKzLEFR



Options for node "demo" X
Category:
[GeneralOptons ]
Static Analysis
Runtime Checking
C/C++ Compiler Library Options 2 MISRA-C:2004 MISRA-C:1998
s sy Target Output Library Configuration Library Options 1
Custom Build Processor variant
Build Actions
e
Debugger
Simulator O Device None The
CADI
CMSIS DAP o None
DB Server O CMSIS-Pack
I-jet
J-Link/J-Trace Endian mode Floating point settings
TI Stellaris .
Nu-Link ® Little FPU None
PE micro O Big
ST'UNK D rr(l‘.‘wtqr-- -
Third-Party Driver BE32
TI MSP-FET BE8
TI XDS
TrustZone
DSP Extension
Mode Secure
Advanced SIMD (NEON)
Cancel
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@ demo - AR Embedded Workbench 10 - Arm 8.50.9 - o x
File €60 View Piojed Debug Dosnamby Kk Tooh Window Heo
- .
aanagxmﬂ 2 .‘Q""(°>Dw.."@"°ln1r‘l Q3.5 &
W 0K | maing x A UART ¢ Startup ACMITFON S Syitom ACMIZFONL A EFLATHL WAL EFiash ELM — ey
a‘. maing fol oen ey
s SN oo e
@ domo - Dobug v * ¢ main Oxe€0 0x2000°0008
0 dAOMRFY : The application entry point. Oxe8d  Ox4000° 4400
= &) System ACMRFOx None Oxefl: 0x1000° 0300
EHAL 2 OmeSc: 0x0000"0fce
B HAL DMAC : None Oxe%0. 0x0000°111c
b QHAL EFLASH e kashrreretane desasesbeetesane wrsnnn tesesertne trsasssren testes trrasesrnn wesbernsns Oze94. 0x2000°0050
DAL EFIash_EXib % |int main(void) Oxe%8 . 0x0001' 0001
B HAL GRIO¢ ( Owadc Ox2000° 0064
o DHAL UART ¢ st asin(woid
5 Bmanc System_Init();
« ol Oupue sain
vart_Init (115200); _

' n-.. ' ext7te outds
Gpio_set led(); Uar

" Gneat. Oxatel
- | while (1) o Oxeal Ox0240

Debug Log - ax

Tha Sep 292022153746 Hardware reset with syateqy 0 wes pericemed
ms.on 2022 1537 46 48 byses veribed (70 38 Kbytes/sec)
53745 Losded debugee. CV.
5§37 46 Paset Hok core ofer resetvia DEMCRVC_CORERESET
53745 Reset Reset device wa AIRCA SYSRESETREQ

Tha Sep 28 2022153746 SoMware reset was podormed

Thu Sep 29, 2022 15:37 46 Torgat reset

=. &f7
BRIGSAAXHTHEBRES, FEZXT RESET®E, BFAHIETT, M GPIOO
L% LED KT IAMR AB), SRR (BEARBIME) FMKNT:



void Uart_Init(uine32_t fu32_Baudrate)
B{
Uart2_Handle.Instance = UART2;
Uart2_Handle.Init.BaudRate = fu32_Baudrate;
Uart2_Handle.Init.Wordlength = UART_WORDLENGIH_B8B;
Uart2_Handle.Init.StopBits UART_STOPBITS_l1;
Uart2_Handle.Init.Paricy UART_PARITY_NONE;
Uart2_Handle.Init.Mode UART_MODEZ_TX_RX_DEBUG;
Uart2_Handle.Init.HwFlowCtl UART_HWCONTROL_NONE;

HAL UART Init(&Uart2_Handle);

/* UART_DEBUG_ENABLE control printfS */

pPrintfS("MCU is running, HCLK=%dHz, PCLK=%dHz\n", System Get_SystemClock(), System Get_APBClock());
-}

void Gpic_set_led()

B{
printfS(“This is USER LED TEST \r\n");
GPIOD_Handle.Pin = GPIO_PIN_3;
GPIOD_Handle.Mode = GPIO_MODZ_OUTPUT_PP;
GPIOD_Handle.Pull = GPIO_PULLUP;
GPIOD_Handle.Alternate = GPIO_FUNCTION_0O;
HAL GPIO_Inic(GPIOD, &GPIOCD_Handle) .'i
vhile (1)

=

HAL_GPIO_WritePin(GPIOD, GPIO_PIN_3, GPIO_PIN_SET);
System Delay MS(500);

HAL_GPIO_WritePin(GPIOD, GPIO_PIN_3, GPIO_PIN_CLEAR);
System Delay MS(500);
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tput : None Oxe30 0x0000" 1110
.............................................................................. Oma®4. Ox2000' 0050

Oxe’8: 0x0001'0001

main (void) Oxedc 0x2000°' 0064

»
_ |System_Init();
Y AL

7 lvart_tnit(115200) _

Oxt7¢f OxtbS
Gpio_set_led(): Basd Teiti118200
while(!) Onmat n-zo-n
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e vax
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Fle B View Projed Debop Duassemdly Jlek Took Window Melp
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@ demo- Debug v : None BRIt EUKECSQJ:
2l ACMIFD RERAARRTRAARARRRRRARARR AR AR RIS AR AR AR AR AN A AR AR
- ) System ACM3ZFI % int main(void)
o i HAL
|2 DHAL DMAC 2
2 BHALERASHc o | EiSESRNGIE0E
| DHAL_EFlash EXib
= DHAL GF10c o " "
L DHALUARTC Uart_Init(115200);
2 B manc AEE AL
i Ot REmA Gpio_set_led();
while ()
{
I }
| domo «
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) Disassembly

Oxe80
Oxeld
Oxe88
Oxe8c
Oxe30
Oxedd
0x098
Oxe9c

0x2000°0008
0x4000° 4400
0x1000°0300
0x0000°0fcc
0x0000°111¢
0x2000° 0050
0x0001 0001
0x2000° 0064

a2in

OL el WAL Dxibf
Oxeab. 0x20el
Oxead: Ox0240

FWr S, Debug Log A ERXT
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5 D 0 2@ weon s { OxeS4 Ox6901
O® wewatn «Q wen2 a++; Oxe56 Oxlcdd
7@ csama @ wuons HALGPIO: WEStaPLA (GRIOD, GPIO.PIN.3; GRIO/® e
48
Bl e @« wuos | System_Delay MS(500); >
WOy lean HAL_GPIO_WritePin(GPIOD, GPIO_PIN_3, GPIO_P OxeSc 0x2308
@ s M 3 OxeSe: 0x2003
Systam | Delay ad ): Oxes0  Oxt7tt Oxtec
Memory »
Ropiter » oxest. Ox2dte
Oxebé  Ox0064
= Oxebd 0%0920
=3 stac » »
Detng log €, tymbose Memsey v ax
Log | Temnstio
g Maces » [debugee C\Users\$6182DesitopiompiaitDebug Exe\demo out
TSN smbon Jah core atee resetvia DEMCRVC_OORERESET.
™oy foset device via ARCR SYSRESETREQ
TS = reset was pedomed
Thu§ B images sot
™S & com nt ot Code @ mainc 655 hype defech (suto)
™E jint vt Code @ main ¢ 48.5. hype: deloalt (auto)
Fault mception newer
i T — vax

%%@ IZIZEJ:ﬁE’\JT? KE Rk

38 View > Register ?Tﬁ%ﬁ%%ﬁ A,

BRHE CPU FFss . TUMNERF
BREETENTOFERE.
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c | B}
xe o"_

.c HAL_EFlash_EX.lib

Team

*hAA A AL A K

k ok koo ok Ak

*hEAA AKX A

te)

File Edit Project Debug Disassembly J-link Tools Window Help
: U I‘J Messages » C v £ Q
r 1
Workspce | @] Workspace X | mainc X HALUART.c Startuff™
Debug Source Browser 2 Find Group: Current CPU F
Files C.STAT »l 1 * @date Name Value
* gauthor 1.® OxE£EE
B @deny | CRUN * RS OxEfEf
) WA * @brief
E Breakpoints R9 Oxffff
B Akrxkkxkixix M pig OxEEEE
|
"?_;B" i */ R11 OxE£EE
Watch » ¥ " R12 0x0000
}_E] ) #include "AH + APSR 0x0000
LTE i uve waten int a=0; # IPSR 020000
(o 5@ aucvat UART_HandleT|sEPSR 0x0100
ogm Ao GPIO_InitTyq Z¢ oo
= £ .4
o Local *ok ok ko kA
O, o / : IR 0x0000
€ statics * functi % PRIMASK 0x0000
* Describt i]®CONTROL 020000
»
i 7 CYCLECOUNTER 0
Registers » n Registers 1 CCTIMER1 0
@ Disassembly B Registers 2 CCTIMER2 0
Idemo Stack » B Registers 3 CCSTEP 0
Debug Log &% Symbolic Memory T Registers 4 K >
Log | Teminaivo BB Register User Groups Setup
Thu § Macros » 2set
ThuS & symbols vint hit: Code @ main.c:65.5, type: default (auto)
Thu§ oL inthit Code @ main.c:48.5, type: default (auto)
0 Thug | CodeCoverage must have a name
09 Thug[E] Images must have a name
D ThuS 4 | cores ‘must have a name
¢4 Thu$ N must have a name
Fault exception viewer

O o A f R e A e e e e

Keil+GCC

1.1 Keil 2% & A

BEARRERFERAEXEES B Keil B, ABAMERERER,

1.2 GNU 88K & (GCC) REIR

ARM GCC Zgi¥s8 T # itk https://developer.arm.com/downloads/-/gnu-rm


https://developer.arm.com/downloads/-/gnu-rm

Downloads: 10.3-2021.10 October 21,2021

What's newin 10.3-2021.10

This release provides mitigation for the VLLDM instruction security
vulnerability.

In this release:

gcc-arm-none-eabi-10.3-2021.10-win32.exe

Windows 32-bit Installer (Signed for Windows 10 and
later) (Formerly SHA2 signed binary)
MD5: 8d0f75f33f9e3d5f9600197626297212

gcc-arm-none-eabi-10.3-2021.10-win32.zip
Windows 32-bit ZIP package
MD5:2bc8f0c4c4659f8259c8176223eeafcl

OfF ARFEF exe THRF, BIAZR % Bk A C:\Program Files (x86)\GNU Arm
Embedded Toolchain\10 2021.10;

QFERBESE zip R, B XM C\Keil_vS\ARM Xk NEE, REBF
# C:\Keil_v5\ARM\gcc-arm-none-eabi-10.3-2021.10

CAK u‘_\.'uh.RM'-_-:_pu armye-none-eatl- 105-2021,.10

A rone- bl 2211
bin 221 k1
b 202211 &1

Lhare 1

R EREEEE Keil B{E B

1.3 Keil + GCC 8% 8

OFTFF Keil [, =35 E7~3%4$H Manager Project Items



FAA-ACM debug demo\ACM32F0x0_ModulesDemo\ModulesDemo_Rev2.0.3\ModulesDemo\UART\de
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

ﬁﬁﬂﬂ\f.dml Ol | BRI R|EEE G| e
AN R I‘_‘“é‘ &4‘ Project v &K )

lProJut Ll x| ) mainc | [] Startup ACM32FONX0s |

B

2% Project: Project Redistribution and use in source and
. modification, are permitted provided

= &3 Project . - Redistributions of source code musi

= & CoreDriver/CMSIS notice, this list of conditions anc

I_', core cmO.h - Redistributions in binary form musi

notice, this list of conditions anc
documentation and/or other material

@fE#EREF, Folder/Extensions 31T H1%E#% Use GCC Compiler (GNU) for
ARM projects, Folder IE N\ GCC L% Hx

Project Items Folders/Extensions |Books | Project Info."[.ayerl

1 cmsis acch

Development Tool Folders: Defautlt File Extensions:
™ Use Settings from TOOLS.INI: cs e
Tool Base Folder: |C:\Keil_v5\ARM\ Cs++ Source: |"cpp
EIN C\KﬂI_V5\ARM\BIN\ Asm Source: “s* “smc:“a”
INC: Object: [obj: "o
LIB: Library: |"lib
Begﬁlerl Document: | t«d; “h: “inc; *md
[~ Use ARM Compiler I"RHMCLANG": " MARMCC" |

Setup Default ARM Compiler Version |

[V Use GCC Compiler (GNU) for ARM projects
Prefix; [am-none-eabi- Folder: ][sm Fies (x86)\GNU Am Embedded Toolchain\10 2021.1¢ _|

| 1) 4 I Cancel | Help |

B = #El7R#%48 Configure target options

w5

File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
NBE@| ¥ LBR|90¢| = | PRMAR|EEEKE D As@Q-loo@
§ 2 | B erojeat SN R BT ]

p"”fd Ll < | X Options for Target...
2% Project: Project Configure target options
£ 43 Project

@7 B R |, Output E£Id, fNE%EF Creat Executable, NFEZEE Linker



HRECE A, anRiEFE Creat Library N AT 7E Linker FRECE A4+,

Device | Target Listing | User | CC | Assembler | Linker | Debug | Utilities |

Select Folderfor Objects... | Name of Executable: [Project

[~ Create Batch File

| OK I Cancel Defaults | Help |

[ ¥

GHBZE CC %I, Include Paths il CMSIS, Device. HAL FEZHE3¥K12

Misc Controls #1 FO Z %170 -mcpu=cortex-m0 -mthumb -ffunction-sections -
fdata-sections,



Options for Target 'Project’ X

Device | Target | Output | Listing | User  CC Assembler | Linker | Debug | Utilities |
— Preprocessor Symbols
Define: I
Undefine:
~ Code Generation
¥ Enable APCS (ARM Procedure Call Standard) Optimization: | <defaut> =l
3 o Code Wamings: |Level 1 LI
v Calls between ARM and THUMB Instruction Set
¥ e Clebeneen [™ Strict ANSIC
¥ Compile Thumb Code

hg;:e I..\..\..\Core_Drivers\CMSIS:..\..\..\Core_D‘ivers\Devioe:..\..\..\Core_Dﬁvers\HAL_Dﬁva':..\..\..\Cor J
S

Misc I-mcpu-corlex-mﬂ -mthumb ffunction-sections fdata-sections
Controls

Compiler  |-¢ -mepu=cortex-m1 mthumb -gdwarf-2 -MD -Wall O -mapcs frame -mthumb-interwork -|
OWW ./ ./ /Core_Drivers/CMSIS -| _./_/_/Core_Drivers/Device -| ../../../Core_Drivers/HAL_Driver -|

0K Cancel | Defaults Help |

©fZE Assmbler ¥£If, Misc Controls FO %7 il-mcpu=cortex-m0 -mthumb,,

Device | Target | Output | Listing| User | CC |L1'nker| Debug | Vtilities|

— Language / Code Generation
¥ Enable ARM/Thumb Interworking

Paths

Misc
c I-mcpu-corlex-mﬂ -mthumb

Assembler |-mcpu=cortex-m1 -mthumb —gdwarf-2 -mthumb-nterwork ~MD * d -mcpu=cortex-m0 -mthumb -
m IC:/Keil_v5/ARM/CMSIS/Include -1"C:/Program Files (x86)/GNU Am Embedded Toolchain/10

0K Cancel Defaults | Help |

4




@ECE Linker 3£, mMHB@HETA, {X7E1%$F Creat Executable BfEE7E
Linker Script File RECEMIASN M, BWHAXHE A E TERERP.

Misc Controls 75/il-WI,—gc-sections |, N 1F AL FEIEIN<-| FE L >F ot sE

=

Devicel Targetl Dutputl Listingl User I cC I Aszembler Debug I Utilities I

Text Start: |
™ Enable Garbage Collection

™ Do not use Standard System Stastup Fles Deta Stat: |
™ Do not use Standard System Libraries BSS Start: |
™ Use Math Libraries

L'*‘-"rﬁqﬂgt I,.\.‘\..\Core_Dﬂvers\Device\ACMZiZF&ﬂ,lds J Edit... |
pndl|
i
Include I__\_.\..\Core_Dnvers\HAL_Driver\Src J

Paths
Misc -WI -gc-sections —specs=nosys.specs JHAL_EFash_EX A
controls

v

Linker |.-T _/./../Core_Drivers/Device/ACM32F0x0 lds -mcpu=cortex-m1 -mthumb -mthumb-nterwork -W1 -Ma

control |5 /Objects/Project eff
string

| 0K I Cancel | Defaults | Help |

@ H S i%1EM, CMSIS i cmsis_gcc.h x4, Device E# GCC £ H
19.S B34 (Startup_ ACM32F0x0_gcc.S)

= &3 CoreDriver/CMSIS
_] core_cm0.h
I_:] cmsis_gec.h I
= i CoreDriver/Device
] ACM32Flih
@ ) System_ACM32F .c
System ACM32F__ .h ‘
_] Startup ACM32F.  gcc.S)

1.4 Keil + GCC i {5 A5 BA

FRERESR Keil B, FEIENZMEA GCC Hixan, 7 Keil FRIET L&
fTBk#: (fRiE%E F12) IhsE.



ERERAERED
—. £ GCCIMET, printf & E &6

7 Keil 1 C FEdR, printf, scanf & N i sk 021819 fpute. fgete SRCE
REEREN, FUBNRABEARNNIRDEE GXHAN RN T IS
printf, scanf R R EBRE . 5 keil C EEX{A GNU C E TR REURZE 2@
_read. _write RELIA, BINRBEIRPEMNETE X T IALIERSF I

o6
Be J o

C++
#ifdef  GNUC__
int __io_putchar(int ch)

{
Uart_Debug->DR = ch;
while ((Uart_Debug->FR & UART_FR_BUSY));
return ch;
}
int _write(int fd, char* buffer, int size)
{
for(int i = @;i<size;i++)
{
__io_putchar(*buffer++);
}
return size;
}
#else
int fputc(int ch, FILE *f)
{
if (Uart_Debug == NULL)
{
return 9;
}
Uart_Debug->DR = ch;
while ((Uart_Debug->FR & UART_FR _BUSY));
return ch;
}
#endif

Eclipse+GCC



1.1 Eclipse &%
(DEclipse Tk #bE https://www.eclipse.org/downloads/ Bk % 2515 F2 5 BE W 31T
Q@ TREMENHITH, FEATEFRR, SELEERCAER

eclipseinstaller u com =

type filter text Q

@ Eclipse IDE for Java Developers

The essential tools for any Java developer, including a Java IDE, a Git client,
XML Editor, Maven and Gradle integration

@_ Eclipse IDE for Enterprise Java and Web Developers

Tools for developers working with Java and Web applications, including a Java
IDE, tools for JavaScript, TypeScript, JavaServer Pages and Faces, Yaml,...

@ Eclipse IDE for C/C++ Developers
An IDE for C/C++ developers.

% Eclipse IDE for PHP Developers

The essential tools for any PHP developer, including PHP language support,
Git client and editors for JavaScript, TypeScript, HTML, CSS and XML.

Clirk here tn

% Eclipse IDE for Eclipse Committers

Package suited for development of Eclipse itself at Ecllpse org; based on the

Felie e e P e e = Al — AT~ la Il_..l._a._l___ J-I P [P |

ORTRERTERERE, WMREMED5E IRE HIRASLENAE, T



L

eCIipSEInSta”er by Oomph

details

Eclipse IDE for Embedded C/C++ Developers
@ An IDE for Embedded C/C++ developers.

wnload.eclipse.org/justj/jres/17/updates/release/latest v &

Java 17+ VM
\eclipse\embedcpp-2022-09 =

Installation Folder C:\Users\

¥ (reate start menu entry

v create desktop shortcut

< INSTALL

< BACK

ORERER, FRENZTHRE, LHHEERMHET




eCIipSEInSta”er by Oomph

details

Eclipse IDE for Embedded C/C++ Developers
@" An IDE for Embedded C/C++ developers.

whiload.eclipse.org/justj/jres/17/updates/release/latest ¥

Java 17+ VM
\eclipse\embedcpp-2022-09

Installation Folder C:\Users\

v (reate start menu entry

¥ create desktop shortcut

X Cancel Installation

O%KEME, ~ifi LAUNCH B3f eclipse, FHigiafFRE

0



eCIipSEInSta”er by Comph

details

Eclipse IDE for Embedded C/C++ Developers
@+ An IDE for Embedded C/C++ developers.

whload.eclipse.org/justj/jres/17/updates/release/latest ¥

Java 17+ VM
C\Users\imtone\eclipse\embedcpp-2022-09

Installation Folder

v (reate start menu entry

¥ create desktop shortcut

» LAUNCH

show readme file
open in system explorer
keep installer

< BACK

1.2 Eclipse {¥#
FTFT eclipse {4, <3 IHAIELLIESF workspace, FREN TEIFfR:

L



S Eclipse IDE Launcher X

Select a directory as workspace

Eclipse IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: |F\eclipse-workspace v| | Browse...

(] Use this as the default and do not ask again

Launch Cancel

Workspace HAFRBCEX, FRFHHERMH.

ACM32 %%l MCU 2 ARM 1%, FrIAFTE TH 1M ZIFHIFE ARM AIZH R E=R,
THERET xpack IR N gRiEss, TEHbIE xpack-arm-none-eabi-gcec-11.2.1-1.2-
win32-x64

type filter text Global Arm Toolchains Paths Grovi
> General Configure the locations where various GNU Arm toolchains are installed. The values are stored within Eclipse. Unless redefined more specifically, they are
> C/Css used for all projects in all workspaces.
: g:ac:gre“’g Default toolchain: xPack GNU Arm Embedded GCC {arm-none-eabi-gcc) v
> Help Toolchain name: xPack GNU Arm Embedded GCC (arm-none-eabi-gcc)
> Install/Update Toolchain folder:  F:\xpack-arm-none-eabi-gcc-10.2.1-1.1 Browse... xPack...
2 Lfanguage Servers Toolchain name:  GNU Tools for ARM Embedded Processors {arm-none-eabi-gcc)
i ::ZTSW Uovet Toolchain folder: xPack...
Global Arm Toolchains Paths On macOS use Shift+Cmd+"." to show the hidden folders while browsing the file system. xpm uses a .content folder to store the binaries.

obal Bulld Tools Pa

Global OpenOCD Path
Global pyOCD Path
Global QEMU Paths
Global RISC-V Toolchains Path
Global SEGGER J-Link Path
Workspace Arm Toolchains Pa
Workspace Build Tools Path
Workspace OpenOCD Path
Workspace pyOCD Path
Workspace QEMU Paths
Workspace RISC-V Toolchains
Workspace SEGGER J-Link Patt

> Oomph

» Remote Development

> RPM

> Run/Debug

SWTChart Extensions
» Terminal
> TextMate
[rINS Restore Defaults Apply

@Dima @ Apply and Close Cancel

BERNBFENFENNRE, FEFAT xPack Windows Build Tools fRag—L T
B, AREZFEILAEEEERN, KEETETREREIEENEXT, RART
Windows->Preferences->MCU->Global Build Tool Path # A\Zi& EfH, jEEMETAR
EIER:


https://github.com/xpack-dev-tools/arm-none-eabi-gcc-xpack/releases/download/v10.2.1-1.1/xpack-arm-none-eabi-gcc-10.2.1-1.1-win32-x64.zip
https://github.com/xpack-dev-tools/arm-none-eabi-gcc-xpack/releases/download/v10.2.1-1.1/xpack-arm-none-eabi-gcc-10.2.1-1.1-win32-x64.zip

type filter text Global Build Tools Path G v v g
General

C/C++
Changelog
Docker

Help
Install/Update
Language Servers
Library Hover

~

The locations where various Eclipse Embedded CDT build tools are installed. Unless defined more specifically,
they are used for all projects in all workspaces.

I Build tools folder: F:\xpack-windows-build-tools-4.3.0-1

~

xPack...

Browse... I

vV oV v v

Global Build Tools Path

Global OpenOCD Path
Global pyOCD Path

Global QEMU Paths

Global RISC-V Toolchains Pi
Global SEGGER J-Link Path
Worksnace Arm Toolchains

Restore Defaults

@ Apply and Close Cancel

1.3 AR T AR RS

1.3.1 J-Link

OTF J-Link &, 73] https://www.segger.com/downloads/jlink#a] & 3F A~ il A J-
Link k=) &k, AXHEETE T J-Link V7.82 fRA

cumentation Pack

J-Link Software and Documentation pack

B All-in-one debugging solution

B Can be downloaded and used free of charge by any owner of a SEGGER J-Link, J-Trace or

Flasher model.

rs|

V782 v
[2022-10-13]

Windows
& 64-bit Installer

e

& 32-bit Installer

Not all features of it may be available on all J-Link / J-Trace / Flasher models.

@ Updated frequently
B Release Notes
B More information

Windows ARM
& 64-bit Installer

Linux
. 84-bit DEB Installer
& 84-bit RPM Installer

. 32-bit DEB Installer
& 32-bit RPM Installer

& 84-bit TGZ Archive

& 32-bit TGZ Archive

Linux ARM
& 64-bit DEB Installer
& 64-bit TGZ Archive

& 32-bit DEB Installer
& 32-bit TGZ Archive

macOS
& 64-bit Installer
& Universal Installer

& 64-bit Apple M1 Installer

@%ETEME, KRS eclipse f Windows->Preferences->MCU->Global
SEGGER J-Link Path # NZE1&EH, #5E JLink TEBR, ERANT:


https://www.segger.com/downloads/jlink

‘S Preferences o X

type filter text Global SEGGER J-Link Path Pverv g

Global OpenOCD Path Configure the location where SEGGER J-Link is installed. The values are stored within Eclipse. Unless
Global pyOCD Path redefined more specifically, they are used for all projects in all workspaces.
Global QEMU Path

Global RISC-V Toolchains Paths After installing SEGGER updates, restart Eclipse for the defaults to be re-evaluated and use the Restore
Global SEGGER J-Link Path Bolaulichutionto-contigura-th locad
Executable: JLinkGDBServerCL.exe

Workspace Build Tools Path Folder: C:/Program Files/SEGGER/JLink Browse... xPack...
Workspace OpenQOCD Path

Workspace pyOCD Path
Workspace QEMU Path
Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path

> Oomph

> Remote Development

> RPM

> Run/Debug

SWTChart Extensions
> Terminal
> TextMate

® 2 e Apply and Close Cancel

@)3# A\ F| Debug Configurations fit & 71 &

Restore Defaults Apply

i Project Explorer x E% Y § 79 @maincx BAPPc [EAPPh [ System ACM32F0x0.h  [Estdioh  Eli
;I1$ACM32F0X[]7DAP I F25-void Uart Init(void)
New >
E%$$ nstance = UART2Z;
Go Into nit.BaudRate = UART BAUD RATE;
. ) nit.Wordlength = UART WORDLENGTH 8B
Open in New Window nit.StopBits = UART STOPBITS 1;
Show In Alt+Shift+w » nit.Parity = UART_PARITY_ NONE;
) ) nit.Mode = UART MODE TX RX DE
Show in Local Terminal > nit.HwFlowCtl = UART HWCONTROL_NON.
& Copy Crl+C  guaARTZ Handle):
Paste Ctrl+V | x/
® Delete Delete e Disable FIFO(&UART2_ Handle, FUNC E
Source >, NULL, TIONBF, 0);
Move...
i ENABLE control printfs */
Rename... Alt+Shift+R  aoicpT+GCc MCU is running, HCLE=3%dH
s Import...
= Export...
FEAEEAAAAAAAA T A A A A A A A A XA d A5x4 4545%%
Build Project in
Clean Project e application entry point.
ne

Refresh F5 |pe
b e o R e

Close Project

Close Unrelated Project

Build Targets >

Index >

Build Configurations >

Profiling Tools >
© RunAs > mit (&UART1 Handle, gu8_ UART1Test, s
£l 1 C/C++ Container Application s
@ Profile As > ] 2 Local C/C++ Application VA,

Restore from Local History...
#  Run C/C++ Code Analysis
Team >

@ GDB SEGGER J-Link Debugging €I J-Link IBIXMECE, EXENNEER

Debug Configurations...




RIa] £ A J-Link #1TIHIR
eoozeproee 35 o]

Create, manage, and run configurations ﬁ\,
ST EIEN Name: ACM32F0x0-DAP Debug
type filter text Main‘i& Debugger| & Startup % Source| & Common| % SVD Path
/C++ Application Project:
/C++ Attach to Application i
/C++ Container Launcher ACM32F0x0-DAP Browse...
/C++ Postmortem Debugger C/C++ Application:
C/C++ Remote Application Debug\ACM32F0x0-DAP.elf
i C/C++ Unit s =
71 GDB Hardware Debugging Variables...  Search Project... Browse...
=1 GDB OpenOCD Debugging Build (if required) before launching
=1 GDB PyOCD Debugging Build Configuration: Select Automatically v
] GDB QEMU aarch64 Debugging
= GDB QEMU arm Debugging () Enable auto build () Disable auto build
£ GDB QEMU gnuarmeclipse Debt © Use workspace settings Configure Workspace Settings...
= GDB QEMU riscv32 Debugging
DB QEMU riscv64 Debugging
o DB SEGGER J-Link Debugging
] ACM32F0x0-DAP Debug
& Launch Group
.|
Filter matched 17 of 17 items gevelt Apply

@

& Debug Configurations m} X

Create, manage, and run configurations
| |

OCReEX[BEY > Name: ACM32F0x0-DAP Debug
{| Lype filter text Main % Debugger| & Startup“:j/ Source‘Ej Commnn‘ 2 SVD Path‘
/C++ Application J-Link GDB Server Setup
C/C+= Attacr.l to Application Start the J-Link GDB server locally ["] Connect to running target
&1 C/C++ Container Launcher - 5 5 =
7 C/C++ Postmortem Debugger I Executable path:  C:\Program Files\SEGGER\JLink\JLinkGDBServerCL.exe Browse... Variables...
& C/C++ Remote Application Actual executable: C:\Program Files\SEGGER\JLink\JLinkGDBServerCL.exe 5B
€ C/C++ Unit . (to change it use the global or workspace preferences pages or the project properties page) i
= Ggg gardwoacreDEI))ebbuggl_ng Device name: ARMCMO Supported device names
pen ebugging . ) FaTre———
DB PyOCD Debugging Endianness: O Little () Big
DB QEMU aarch64 Debugging | | Connection: Quss O | (USB serial or IP name/address)
DB QEMU arm Debugging Interface: O SWD () JTAG
GDB QEMU gnuarmeclipse Debt || | Initial speed: © Auto () Adap ()|Fixed 1000 kHz
] GDB QEMU riscv32 Debugging GDB port: 2331
[ GDB QEMU riscv64 Debugging Pl
~ [ GDB SEGGER J-Link Debugging SWO port: 2332 M Verify downloads [ Initialize registers on start
[£1 ACM32F0x0-DAP Debug Telnet port: 2333 Local host only [ |Silent
& Launch Group Log file: Browse...
Other options: -singlerun -strict -timeout 0 -nogui
Allocate console for the GDB server Allocate console for semihosting and SWO
GDB Client Setup
Executable name: ${cross_prefixjgdb${cross_suffix} Browse... Variables...
Actual executable: arm-none-eabi-gdb
Ak i
I
Filter matched 17 of 17 items Reyert Apply

@ Close




Create, manage, and run configurations gx,

FEX L - Name: ACM32F0x0-DAP Debug

type filter text [ Main # Debugger & Startup % Source ™ Common [=. SVD Path

[EC/C++ Application SVD file (used by the peripheral registers viewer; may be .svd.zip)

[ C/C++ Attach to Application - R - =
[ C/C-++ Container Launcher File path: C:\Usersy \AppData\LocalhVArm\Packs\Aisinochip\ACM32F0X0\1.0. I\ACM32FOX0.svd Browse.. Variables...

& C/C++ Postmortem Debugger

[ C/C++ Remote Application

€0 C/C++ Unit

© GDB Hardware Debugging

7 GDB OpenOCD Debugging

[© GDB PyOCD Debugging

1 GDB QEMU aarch64 Debugging

 GDB QEMU arm Debugging

© GDB QEMU gnuarmeclipse Debugging (De
7 GDB QEMU riscv32 Debugging

= GDB QEMU riscve4 Debugging
« ¥ GDB SEGGER J-Link Debugging
(€] ACM32F0x0-DAP Debug
 Launch Group

1
Filter matched 17 of 17 items

Reyert Apply

? | Debug Close

ACM32 18x PACKS %5, SVD XHoJEMEXXHRA RS, R5|HILA
C:\Users\ [ F & \AppData\Local\Arm\Packs\Aisinochip

FCESERl/E RN B] 2 A J-Link 2471

1.3.2 CMSIS-DAP

DAP Hi{ FZE A OpenOCD i, BRIME EARAZHTRE X ACM32
R eFlash BB, BLEERERN, TEFEBIUCREMNMRA, BN
B EFRA openocd-v0.11.0-i686-w64-mingw32, EEFILIZIMAMAZIFEEMNEXT,
ik &1 eclipse #9 Windows->Preferences->MCU->Global OpenOCD Path # \ F|1%
EF, #5F OpenOCD TEMBF ERMNT:



& Preferences m] X

type filter text Global OpenOCD Path v v §
Changelog Configure the location where xPack OpenOCD is installed. The values are stored within Eclipse. Unless redefined more

> Docker specifically, they are used for all projects in all workspaces.

> Help

> Install/Update After installing OpenOCD updates, restart Eclipse for the defaults to be re-evaluated and use the Restore Defaults

> Language Servers button to configure the new location.

> Libraiy Hover Executable: openocd.exe

Folder: FA\eclipse_workspace\openocd-v0.11.0-i686-w64-mingw32\bin Browse... xPack...

Global Arm Toolchains Paths

obal Build Too ath
Global pyOCD Path
| Global QEMU Paths
Global RISC-V Toolchains Paths
Global SEGGER J-Link Path
| Workspace Arm Toolchains Paths
Workspace Build Tools Path
Workspace OpenOCD Path
Workspace pyOCD Path
| Workspace QEMU Paths
Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path
> Oomph
> Remote Development Restore Defaults Apply

nnka

@ s Apply and Close Cancel

%X J5 3 A\ % Debug Configurations EEETIE F, W7 GDB OpenOCD Debugging £
2 DAP HIH AL E, BXUERMECEERITIE A DAP #47ER, 1R AYFC & Ui an & P

78
Create, manage, and run configurations ﬁ
ER@X BV v

Name: ACM32F0x0-DAP Debug OPOCD
I Main % Debugger & Startup & Source & Common 7 SVD Path

type filter text

+ EIC/C++ Application =
T C/C++ Attach to Application Project:
[ C/C++ Container Launcher ACM32F0x0-DAP Browse...
¥ C/C++ Postmortem Debugger C/C++ Application:
% C/C++ Remote Application Debug\ACM32F0x0-DAP.elf
e i
= g’g;;;:::.:a,e Debugging Variables..  Search Project... Browse...

«  GDB Open0OCD Debugging
=1 ACM32F0x0-DAP Debug OPOCD
o 23: gﬁifm;g;fmggmg _) Enable auto build ) Disable auto build
 GDB QEMU arm Debugging O Use workspace settings Configure Workspace Settings...
% GDB QEMU gnuarmeclipse Debugging (Depi
T GDB QEMU riscv32 Debugging
1 GDB QEMU riscvb4 Debugging
¥ GDB SEGGER J-Link Debugging
# Launch Group

Build Configuration; Select Automatically v

Filter matched 19 of 19 items Reyert Apply

@ Debug Close
|- A

IR &E 5| cmsis-dap.cfg 5 acm32f0x0.cfg FAN STt




Creale, manage, and run configurations ﬁ

[CErEN BT~
type filter text

» [0 C/C++ Application 0Open0CD Setup
[E C/C++ Attach to Application % Start OpenOCD locally
[E C/C++ Container Launcher

[ C/C++ Postmortem Debugger Executable path: ~ ${openocd_path}/${openocd_executable} Browse.. Variables..
€1 C/C++ Remote Application Actual executable: Fleclipse workspace\openocd-v0.11.0-i686-w64-mingw32\bin/openocd.exe

€ C/C++ Unit (to change it use the global or workspace preferences pages or the project properties page)
[© GDB Hardware Debi

Name: ACM32F0x0-DAP Debug OPOCD
11 Main % Debugger| # Startup % Source| = Comman| = SVD Path|

GDB port: 3333
3 OPOCD Telnet port: 4444
[ GDB PyOCD Debugging " 6666
51 GDB QEMU aarch64 Debugging Config options: - "F\eclipse y d-v0.11.0-1686-wb4-mingw32\share\openocd\scripts\interface\cmsis-dap.cfg” -1 °F: -
[© GDB QEMU arm Debugging \eclipse_workspace\openocd-v0.11.0-i686-w64-mingw32\share\openocd\scriptsitarget\acm3210x0.cfg” .
& GDB QEMU gnuarmeclipse Debugging (Depr
[ GDB QEMU riscy32 Debugging focate console for OpenoCD “Allocate console for the Leinet connection
[ GDB QEMU riscv64 Debugaing GDB Client Setup
> [©/GDB SEGGER J-Link Debugging % Start GDB session

# Launch Group

Executable name: ${cross_prefixjgdbs{cross suffix} Browse.. Variables...

Actual executable: arm-none-eabi-gdb

Other options:

Commands: set mem inaccessible-by-default off

Remote Target

Filter matched 19 of 19 items Reyert Apply

@ Close

Create, manage, and run configurations /ﬁ,

CEREX|BYT~
type filter text
TIC/C++ Application
E1C/C++ Attach to Application N o
#1C/C++ Container Launcher File path: Ef\Users\ AppDatat\LocahArm\Packs\AisinochipVACM32F0X0\1.0. 1WACM32F0X0.svd Browse... Variables...
%C/C++ Postmortem Debugger
[ C/C++ Remote Application
i C/C++ Unit
©1GDB Hardware Debugging
1 GDB OpenOCD Debugging
] ACM32F0x0-DAP Debug OPOCD
1 GDB PyOCD Debugging
[#1GDB QEMU aarch64 Debugging
%1 GDB QEMU arm Debugging
[ GDB QEMU gnuarmeclipse Debugging (Dept
#1GDB QEMU riscv32 Debugging
1 GDB QEMU riscvb4 Debugging
. E1GDB SEGGER J-Link Debugging
& Launch Group

Name: ACM32F0x0-DAP Debug OPOCD

|1 Main % Debugger & Startup & Source £ Common . SVD Path

SVD file (used by the peripheral registers viewer; may be svd.zip)

<

Filter matched 19 of 19 items Revert Apply

@ Debug Close
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